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1 Introduction

1.1 Product Overview

The Web Panel provides a Web-based alternative to traditional hardware control panels
and offers more flexibility when it comes to button layout on the screen and to accessibility.
The Web Panel, combined with a touch screen display, gives you both the ease-of-use of a
traditional control panel and the flexibility of the Web Panel.

The Web Panel supports control of VikinX routers (or any third-party router integrated with
Multicon) and Flashlink equipment through invocation of pre-defined setups (so-called
salvos). The Web Panel comes with control panel templates that can be configured for most
purposes.

The Web Panel server software is installed on a Windows server machine, while the user
interface is accessed from any client computer running a Web browser. Switching between
different control panels is as easy as following a Web link.

Version 3.0 of the product is also tablet ready and may be accessed from Chrome or Safari
mobile browsers on Android™ or iOS™ devices. This enables such devices to be used for
control of VikinX or Flashlink systems.

i nevien

Source

VSRC001 | VSRC002 ‘ VSRC003 VSRC004 VSRC005 VSRC006 VSRC007 VSRC008

VSRC008 VSRC009 VSRC010 VSRCO011 VSRC012 VSRC013 VSRC014 VSRC015

Destination

VSRC001 | VSRC002
A

Function

Published: 01/02/2014 09:44:42  Licensed to Network Connection status: Operational [l

Key features:
o \Web-based user interface for VikinX router control
o Full support for virtual router, categories, salvos, lock and protect of destinations
e Support for multiple users with access control
o Configurable Web Panel templates available (software configurable buttons)

e Client log-in via standard Web browser (platform independent router control from
PC, Mac or Linux)
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1.2 System Overview

The Web Panel Server enables clients to control routing and signal processing resources
via a standard web browser. The application runs on a standard Windows computer/server
and uses Internet Information Services (IIS) as its web server.

Internet Web Panel Multicon Signa.l
Server Controller Processing
Explorer
AV
Firefox Thlrd-[:.)arty
Routing

A client connects to the Web Panel Server via HTTP and retrieves the necessary web
pages. A Web Socket connection is established between the client and the Web Panel
server for handling user actions and feedback.

The Web Panel Server also connects to a Multicon controller for handling router commands
and status.

Note! Running the Web Panel Server requires a Multicon controller.
Web Panel server is not supporting a direct connection to a Sublime router on
TCP/IP.

The Web Panel server loads a configuration created by the administrator using the Nevion
Configurator. All the configuration files can be uploaded to the Web Panel server by the
Nevion Configurator.

nevion.com | 5
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2 Installation

The Web Panel server may be installed from a CD delivered by Nevion or from an
installation file downloaded from www.nevion.com.

Note! Version 3.0 of the product is highly recommended and this version is
designed for use with Multicon controllers

2.1 System Requirements
In order to run the Web Panel Server, please verify these minimum hardware requirements:

— 1 GHz or faster processor

- 1GBRAM

— 1 GB free disk space

— 100/1000 Mb/s network interface

The following operating systems are supported for the Web Panel Server:
— Windows Professional 7
— Windows 8 Pro
— Windows Server 2008 R2 Standard
— Windows Server 2012 Standard

2.2 Client Requirements

The following browser requirements applies for the clients:
— Internet Explorer 10 and newer
— Firefox 25 and newer
— Chrome 31 and newer

Supported browser for mobile devices
— Chrome 31 and newer

Note! JavaScript must be enabled in the web browser to use the Web Panel
product.

2.3 Firewall Requirements

The following firewall openings are required from client computers (web browser) to the
Web Panel Server:

e TCP port 80 (HTTP)
e TCP port 10002 (Web Sockets)

The following firewall openings are required from the Web Panel Server to Multicon
controllers:

e TCP port 4381 (MRP)

2.4 Web Panel Server

Follow these steps to install the Web Panel server:

1. Double-click on the WebPanelServerinstaller_X.Y.Z.exe installation package.

nevion.com | 6
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2. Follow the instructions given by the installation wizard.

Click “Next >” to proceed.

License agreement

1 Nevion WebPanel Server - InstallShild Wizard =]
License Agreement A ‘

Please read the following license agreement carefully. s g

END-USER LICENSE AGREEMENT FOR NEVICN SOFTWARE PRODUCTS -

June 6, 2006

This End-User License Agreement ("EULA") for Nevion's

software ("Web Panel") is a legal agreement between you
(either an individual or an entity) and Nevion and its
suppliers. You may install the Web Panel on the single

computer or on the nodes of computer networks for which

@ T accept the terms in the license agreement;

() 1 do not accept the terms in the license agreement

InstallShield

[ <Back || mewt> |[ caneel |

Select the “I accept the terms in the license agreement” and click “Next >” to

proceed.

Destination folder

1 Nevion WebPanel Server - InstallShild Wizard =]

Destination Folder Y ‘
Click Next to install to this folder, or dick Change to install to a different folde & g‘

Install Nevion WebPanel Server to:

_4/ C:\Program Files (x86) \Nevion\WebPanelServer|

InstallShield

[ <Back || mewt> |[ cancel

Verify that the destination folder is correct. Click the “Change...” button if you want

to change the destination folder.

Click “Next >” to proceed.

Summary

Click “Install” to install the Web Panel server after verifying the summary.

The installation program will now install the Web Panel server.

Finished

Click “Finish” to complete the installation

7. Run as administrator

nevion.com | 7
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[

&

Mewvion
WebPanel
Server

Right click on the Web Panel Server desktop icon and select “Properties”.

On the “Compatibility” tab check “Run this program as an administrator” and click

1 O K”
B Mevion WebPanel Server Properties @
Security I Details I Previous Versions |
Generl | Shorteut | Compatibility

If you have problems with this program and it worked comecthy on
an earlier version of Windows, select the compatibility mode that
matches that earier version.

Help me choose the settings

Compatibility mode

[ Run this program in compatibilty mode for:

Windows XP (Service Pack 3)

Settings
[ Run in 256 colars
[ Run in 640 x 480 screen resolution
[ Disable visual themes
[ Disable desktop composition
[ Disable display scaling on high DFI settings

Privilege Level

[ r5J[f}1ange settings for all users ]

T

8. Start the Web Panel server by double-clicking the desktop icon.

[

&

Mevian
WebPanel
Server

Open the Web Panel Server application and enter your name, company and product
key you received when you ordered the product.
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Mevion Product Key @
Enter product key
User name:
MyUsername Modify
Company name:
Nevion Madify
Product key:
123455 123455 123458 123455 123455 123156|
OK | | Cancel |

Note! Make sure the company name is identical to the one printed next to
your product key!

9. Open configuration

Click “Cancel” to proceed if no configuration has been created and published yet
using the Nevion Configurator.

2.5 Internet Information Services (IIS)

Note! This procedure is written for Windows 7 and may deviate on other
Windows OS versions.

Follow these steps to install and/or configure IIS:
1. Verify IIS installation

In the Web Panel Server application, open “Tools”->"Internet Information Services

(NS)™. If IS is not installed on your computer, select “Yes” to install it. Web Panels
will not work until IS is installed.

2. Install IS
This step is only applicable if “Yes” was selected in the previous step.

Select “Internet Information Services” as shown below with default features enabled
and click “OK”.
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=0

=

HEE
EEEOERO

[E3]

i

[z

AO000O0O0F

[-1 Windows Features EI@

Turn Windows features on or off @

To turn a feature on, select its check bowx. To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on.

. Games -~
. Indexing Service
. Internet Explorer 11

il Internet Information Services

. Internet Information Services Hostable Web Core

m

. Media Features

. Microsoft NET Framewark 3.5.1

. Microsoft Message Queue (M3MQ) Server

. Print and Document Services

. Remote Differential Compression

. RIP Listener

. Services for NFS

. Simple Network Management Protocol (SNMP)
. Simple TCPIP services (i.e. echo, daytime etc)

. Subsystern for UNIX-based Applications

Tahlet P” Cnmnnnents

OK ] ’ Cancel

3. Configure lIS

In the Web Panel Server, open “Tools”->"Internet Information Services (1IS)”.

Expand the tree on the left hand side of the “lIS Manager” dialog and locate the

“Default Web Site”, right click it and select “Add Virtual Directory...”.

The following settings are recommended:

Alias: WebPanel
Directory: C:\WebPanel (Select C:\ and click “Make new directory” if it does not

exist)

Alias:

Add Virtual Directory

Site name:  Default Web Site
Path:

1}
/

WebPanel
Example: images

Bhysical path:

C\WebPanel E

Pass-through authentication

LConnect as... ] I Test Settings... ]

[ 7 [l

[ ok ][ Cconce

Click “OK”.

4. Reboot the computer to complete IIS installation
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5. After reboot, verify that IIS is installed by opening the following page in a web
browser: http://localhost

The following image should be displayed:

Benvenuto I l ; ;
Welkom

internet information services

7 ‘.Geidlmz

nevion.com | 11
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3 Configuration

To configure Web Panels the Nevion Configurator must be used. This application allows
you to build button configurations for Web Panels and publish the configurations to the web

server.

3.1 Pre-requisites

Before you start making button configurations for Web Panels in the Nevion Configurator,
there are some tasks that should be done. For further information about using the Nevion
Configurator, please see the Nevion Configurator online help.

configure your system with correct levels and mnemonics.

and categories in the virtual router mapping.

Use the Nevion Configurator to detect your system controllers (Multicon) and

Create one or more virtual router mappings for your system. Configure names, icons

Note! Web Panels require a virtual router. It is not possible to configure a web
panel without sources or destinations from a virtual router, except for salvos.

creating the Web Panel button configurations.

3.2 Create Web Panel configurations
Follow these steps to create a Web Panel configuration:

1.

Select “Web panel’->"Web configurations”.

If you plan to use salvos on the Web Panels the salvos must be created prior to

Mevien Configurator - Version 419
Fie  Current system

Ci 5

Refres!

Web panel | Tools  Help

WWeb configurations  Ciri=Shift=P

s [ Virtual Routers [ Saivos

=} Parameters /= Button Configurations.

===

Update panels | IP Settings

A\ Sup_Modular

= Devices
£l Modular frames
Modular rauter
£l Control panels
SUP_GP-16LCD1__|2LCD.
SUP-CP4&MEC3 |2 ME
SUP-MDP-MA ()
= Configuration

B Levels

HD128

Level 1
Level 2
Bl Virtual Routers
VirualRouter 1
=l Protocols.

E| Automation/3rd party control

C-DEMO Serial
Leitch Pass-Thraugh | Serial
MRF

NCE Compact Serial
Serial

Web Configuration List
Show st ofall available web configurations in the system.

Mame Alias.

Help Advanced w

Close

dle

| I 0. 01 Oct 2012 15:26:33 GHT

Click the “New” button to create a new web configuration.

Create new web configuration

nevion.com | 12
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Web Configuraticn
Shows the details ofthe selected web configuraion.

Name: WebConfig Description

Alias:

Controllers. | Control panels | 1P fiters | Publish

Controllers not configured for the Web Panel Controllers made available to the Web Panel
server. server:
Hostname IP address Priority Hostname IP address Port
Add >> 1 SUP_Madular_1 10108 1 4381 e
<< Remove Down

Enter a meaningful name/description for the new web configuration.

Click “Add” or “Remove” to add/remove controllers to be used from the list of
available controllers in the system.

3. Add web panel

Nevion Configurator - Version 419
Fie Currentsystem Webpanel Tools Help
i d Refresh |[&] Upload | (3} System Overview | fiff Lepale il ichual Routace [ sas & ince 2 Buti Update panels | IP Settings

i | Bl Web panel =) ===
N\ Sup_Medular Web Configuratior|
—_— Shows the details of the s| Created Web Panel control panels are added to the current system. Then,

= Devices add the Web Panel control panels to a Web configuration to publish them to

‘your Web Panel server.

E] Modular frames Name:  WebConfig
Modular router Hp12e [ Emi -
S Control panels Alias: Sachasbivieliyie
SUP_CP-16LGD1_[2100... 1 5 Single bus - S8 8x1 %) Single bus - SB 54x1
SUP-CP44MEC-3 |2 ME. Controllers | Control pai ~
ETE AT o j comtee] 5 Single bus - B 16x1 %) Single bus - S8 128x1
= Configuration Control panel configural ©) Single bus - SB 32x1 bie.
Web Pane cients:
Bl Levels
Level 1 i eies e ) Dual bus - DB 8x2 (©) Dual bus - DB 6&x2
Level 2 L2 64x84 () Dual bus - DB 16x2 () Dual bus - DB 128x2 up
E] Virtusl Routers _
VirtualRouter 1 ) EEED-E3=8 T
= Protocols _ _
) Multi bus - MB &x3 © Mulibus - MB 64x64
£ Automation/3rd party control
France TV Serial © Mutibus - M8 16x16 (©) Mukibus - MB 128x128
France TV Serial ) Multi bus - MB 32x32
Leitch Pass-Through | Serial
NGB Compact Serial S ——
NGB Sublime. Serial ) 22 bl S
Pro-Bel SW-P-02 | Serial © Sabo-8 @ Sao-32
Triton Serial
E] Routers (clients) ) Custom [ 64
CDEMO Serial
Leitch Pass Through | Serial
MRP 1P Customize web panel
NCB Compact Serial
INCE Sublime. Serial Max number buttons per row: | 8|
Pro-Bel SW-P-02 | Serial

Sony S Serial o]
Toton o
e || cr. 01 0ct 2012 15:31:10 GHT

Click the “New” button and select a web panel type to add to the configuration
based on the available template. Click “OK”.

4. Create button configuration

nevion.com | 13
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5.

Centrol Panel Configuration Editor

Configuration

=] f=lie- =]

Button colors

Active color;
None -

Inactive color:
Hone -

E3 1 K S

Button Images

Virtual routers ~ VirtualRouter 1 » Sources and Destinations ~ Info Active image:
- Source Name Destination Name -

1 1 |vpsToot

2 2 2 WDSTOC: Click the "Seftings and Bi Inactive image:
3 003 3 [wosT

4 004 4 VDSTO Usethe "CtrI"and "Shift"|
5 5 WDST:

6 6 |vDST 3

T 7 WDST!

g () VDST:

g 8 WDST:

10 10 | WDSTO1

i 11 | VDSTO11

12 12 | VDST012

13 13 | VDST013

14 14 | VDSTO014

15 16 | VDSTO15

16 16 | VDST018

17 17 |WDSTOM7

18 18 | VDSTO18

18 18 | VDSTO18 =

The Control Panel Button Configuration is opened when OK is clicked. For further
information about configuring control panels in the Nevion Configurator online help.

Click OK to complete the configuration.

Add more web panels

Repeat the above step if more web panels should be added to the same

configuration.

Finally select web panels to be added to the configuration and click the Add button.

Create IP filters

‘Web Configuration

Shows the details ofthe selected web configurafion.

Name:

Alias:

Description:

| Controllers. | Control panels‘ IP fiters | Publish

IP filters

Clients connecting to the Web Panel server can be fitered based on their IP address. Create IP fiters to allow only certain IP ranges to connect to your Web Panel server.

Fram
10.1.0.0

Tao
10.1.1.255
Modify
Set Reset

nevion.com | 14
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The web panel product support filtering of client IP address that may connect to it.

Click on “New” to create a new filter and enter from and to IP addresses and click
Set. Multiple IP ranges may be added this way.

7. Publish web configuration to Web Panel server

‘Web Configuration

Shows the details ofthe selected web configurafion.

Name: WebConfig Description
Alias:

Controllers | Control panels | IP fiters | Publish

Target location
Select the location where the web panels will be published

@
z
@
&

Advanced

¥] Configuration (XML}
V] Web pages (HTWL)
V] Style shest (CS5)

V] Graphics (g, gif, png)

oK Cancel

Enter the path where to publish the Web Panel Server configuration or select the
location using the Browse button. The recommended location during installation is
C:\WebPanel

Click “Publish” to publish the files and “OK” to complete the web configuration.

Note! If the Web Panel Server is not running on the same computer as the
Nevion Configurator, it may be necessary to copy the configuration files over
the network using Windows Explorer.

8. Start Web Panel Server

When the Web Panel server is started for the first time, the application prompts to
open a configuration file.

Browse for the configuration file (e.g. C:\WebPanel\WebPanelConfiguration.xml)
and click “Open”.

This message will only appear as long as there is no valid configuration file to be

found when you start the Web Panel server. If a configuration has previously been
opened select “File”->"Open...” from the menu.

9. Set Network Interface

Select “Tools”->"Options...” from the menu and set the appropriate network
interface under “Network settings”.

For more information about options please refer to section 5.1.3.

nevion.com | 15
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3.3 Web Panel Templates

The following Web Panel templates are available and configurable with the button
configuration wizard:

Single bus 8x1, 16x1, 32x1, 64x1 and 128x1

Dual bus 8x2, 16x2, 32x2, 64x2 and 128x2
Multi bus 8x8, 16x16, 32x32, 64x64 and 128x128
Salvo 4, 8, 16 or 32
Custom X buttons

It is also possible to set the number of buttons per row in a web panel. The default is 8.

3.3.1 Single-bus

These templates consists of 8, 16, 32, 64 or 128 source-to-destination buttons and the

standard set of function buttons.

ey eyion

Source

VSRC001 VSRC002
VDST001 VDST001

VSRC009 VSRC010
VDST001 VDSTO001

VSRC003
VDST001

VSRC011
VDST001

VSRC004
VDST001

SRC012.
| VDST001

VSRC005
VDST001

VSRC013
VDST001

VSRC006
VDST001

VSRC014
VDSTO001

VSRC007
VDST001

VSRC015
VDST001

VSRC008
VDST001

VSRC016
VDST001

Function

W uE

Published: 01/02/2014 09:44:42  Licensed to Network

3.3.2 Dual-bus

Connection status: Operational [l

These templates consists of 8, 16, 32, 64 or 128 source buttons, two destination buttons
and the standard set of function buttons.

nevion.com | 16
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DB 16x2

Source

VSRC001

VSRC008 VSRC009

VSRC003

VSRC010

VSRC004

VSRC011

VSRC005

VSRC012

VSRC006

VSRC013

VSRC007

VSRC014

VSRC008

VSRC015

Destination
VSRC001 VS| S
VDST001 VDST002

Function

Published: 01/02/2014 09:44:42  Licensed to Network

3.3.3 Multi-bus

nevien

Connection status: Operational m

These templates consists of 8, 16, 32, 64 or 128 source buttons, 8, 16, 32, 64 or 128

destination buttons and the standard set of function buttons.

MB 16x16

Source

VSRC001 VSRC002

vsrcoos Ml VSRCO10

VSRC003

VSRCO11

VSRC004

VSRC012

VSRC005

VSRC013

VSRC006

VSRC014

VSRC007

VSRCO015

VSRC008

VSRC016

Destination

VSRC012 VSRC002
VDST001 VDST002

VSRC009 VSRC010
VDST009 VDSTO10

VSRC003
VDST003

VSRCO011
VDST011

VSRC004
VDST004

VSRC012
VDST012

VSRC005
VDST005

VSRCO013
VDST013

VSRC006
VDST006

VSRC014
VDST014

VSRC007
VDST007

VSRCO015
VDST015

VSRC008
VDST008

VSRCO016
VDST016

Function

Published: 01/02/2014 09:44:42

Licensed to Network

nevien

Connection status: Operational [l
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3.3.4 Salvo
These templates consists of 4, 8, 16 or 32 salvo buttons and the standard set of function

buttons.

Salvo 1

Published: 01/02/2014 09:44:42

3.3.5 Custom Buttons

Licensed to Network

nevien

Connection status: Operational | |

This template consists of a user defined number of buttons, configurable to any of the
available functions.

Custom

VSRC '

VDST001

VSRC002
VDSTO001

VSRC003
VDST001

VSRC004
VDST001

VSRC005
VDSTO001

VSRC006
VDST001

VSRC001
VDST002

VSRC003
VDST002

VSRC004
VDST002

VSRC005
VDST002

VSRC006
VDST002

VSRC001
VDSTO003

VSRC002
VDST003
VSRC

VDST003

VSRC004
VDSTO003

VSRC005
VDST003

VSRC006
VDSTO003

VSRC001
VDSTO004

VSRC002
VDST004

VSRC003
VDST004

VSRC '

VDST004

VSRC005
VDST004

VSRC006
VDST004

VSRC001
VDSTO005

VSRC002
VDST005

VSRC003
VDST005

VSRC001
VDSTO006

VSRC002
VDSTO006

VSRC003
VDST006

VSRC001
VDST007

VSRC002
VDST007

VSRC003
VDST007

VSRC001
VDST008

VSRC002
VDST008

VSRC003
VDST008

VSRC004
VDST005

VSRC005
VDST005

VSRC006
VDST005

VSRC007
VDST001

VSRC008
VDSTO001

VSRC007
VDST002

VSRC008
VDST002

VSRC007
VDST003

VSRC008
VDSTO003

VSRC007
VDST004

VSRC008
VDST004

VSRC007
VDST005

VSRC008
VDSTO005

VSRC004
VDST006

VSRC005
VDSTO006

VSRC006

VDSTO006

VSRC007
VDST006

VSRC008
VDSTO006

VSRC004
VDST007

VSRC005
VDST007

VSRC006
VDST007

VSRC007
VDST007

VSRC008
VDST007

Published: 01/02/2014 09:44:42

Licensed to Network

VSRC004
VDST008

VSRC005
VDST008

VSRC006
VDST008

VSRC007
VDST008

VSRC008
VDST008

Connection status: Operational m

nevion.com | 18
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4 Operation
4.1 Web Panel Address

To open the Web Panel an IP address has to be entered in the web browser’s address bar.
The address consists of the IP address shown in the Web Panel Server and the virtual
directory created in the IS (e.g. http://<IPAddress>/WebPanel).

Web Panel x

« C' | [4 10.69.7.101/WebPane

Web Panel

Information

Select web panel layouts from dropdown menu in the toolbar.

Supported Internet browsers for desktop devices:

o Internet Explorer 10 and newer
o Firefox 25 and newer
o Chrome 31 and newer

Supported Internet browsers for mobile devices:

o Chrome 31 and newer

4.2 Panel Selection

The user can easily switch between the panels by hovering over the panel selection icon
and clicking the panel name.

SB 16x1
Source

VSRC001 3:Tei MB 16x16 VSRCO04 VSRC005 VSRCO06 VSRCOO7
Category 16
Custom 64

VSRC008 E@mm 520 VSRCO11 VSRC012 VSRC013 VSRC014

4.3 Function buttons
This section describes the functionality of the standard function buttons.

Every function button described here is optional and can be left out of any button
configuration.

4.3.1 Panel Enable
This button is used to enable or disable a Web Panel (all buttons).
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One click on the button changes its state between:

-

-

Enabled Disabled

4.3.2 Take On/Off

This button is used to enable or disable the “Take” button. When the “Take” button is
enabled, all cross point switching must be acknowledged by clicking the “Take” button, for
example when switching a source to a destination or when switching a salvo.

One click on the button changes its state between:

Take
On/Off

Enabled Disabled

4.3.3 Take
This button is used to acknowledge cross point switching when enabled.

When Take is enabled, this button will blink according to level selection when the user tries
to switch the router.

One click on the button acknowledges the currently selected switch command. This button
also has a built in timer turning it off if not clicked within a certain time period.

4.3.4 Lock
This button is used to lock a destination. When a destination is locked nobody can switch it.
The destination must be unlocked before it can be switched again.

To lock or unlock, select a destination and click the lock button. If the selected destination is
already locked, it will be unlocked. Otherwise, it will be locked.

Lock

Locked Unlocked

4.3.5 Protect

This button is used to protect a destination. When a destination is protected nobody can
switch it, except for the user that protected it. The destination must be unprotected before it
can be switched again.

To protect or unprotect, select a destination and click the protect button. If the selected
destination is already protected, it will be unprotected. Otherwise, it will be protected.

Protect

Protected Unprotected
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4.4 Crosspoint Switching
Switching a cross point using source and destination buttons requires a destination oriented
operation.

1. Select which destination to switch

2. Select source

3. Press take to confirm (optional)

4.4.1 Source Buttons
A source button represents a source as defined in the virtual router mapping.

Sources are used in dual- and multi-bus panels.

4.4.2 Destination Buttons
A destination button represents a destination as defined in the virtual router mapping. The
button also displays the current status of the corresponding destination.

The "Breakaway" status indicates that there is a level breakaway on that destination,
meaning that the destination does not match one specific source on all levels.

Breakaway

MIX2

Destinations are used in dual- and multi-bus panels.

4.4.3 Source-to-Destination Buttons
A source-to-destination button switches one source to a pre-selected destination.

CAM1to hC CAM3 to

Source-to-destination buttons are typically used in single bus panels.

4.4.4 Categories

Category buttons are used when there are more sources than source buttons or more
destinations than destination buttons. A category button scrolls through multiple pages of
predefined sources or destinations and changes the contents of the corresponding buttons.

The “VTR” category contains all VTRs.
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o ‘ SAT1 | SAT2 I SAT3 I SAT4 I SATS I SAT6 \

The “SAT” category contains all satellite feeds (SAT).

Clicking the category select button (indicated by a red ring in the figure above), all the
category display buttons change their content accordingly. Please see the Nevion
Configurator online help for more information about categories.

4.4.5 Salvos

Salvo buttons (macro, preset) are used when several cross points are switched to perform
a specified and identical task each time. Typical uses can be: setting up monitor walls,
play&record VTRS, transmission setup etc. One click on a salvo button can for example
send 512 crosspoints in one command.
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5 Administra

tion

The Web Panel Server is a Windows application designed to run without any user
interaction. Once the application is set up and started there is no need for any further user

operations.

5.1 Overview

The user interface displays connected clients, configuration info, connected controllers and

IP address filters.

Web Panel Server - Metwork Electronics ASA

M= X

File  Achions

Toolz  Help

Connected clients

Configuration

Configuration file:

Log path:

Server IP address: 10.10.10.78

C:Mnetpubbw/ebP anelMw'ebConfig. xml
C:MnetpubbwebPanelsLog

Status: Server iz running

JG5_ETHCON Clients: 4415

User IP address:Port Active panel Connected

User: 178 Lock: 1 1010.1080:1161 SE 16«1 04.07 2007 12:37:20

Jser: 10 Lock: 1 10.10.10.87:49355 DB 32«2 04.07.2007 12:37:25

ger 178 Lock: 1 1010101181284 SE 16x1 04.07.2007 12:50:37

Usger: 169 Lock: 1 10.10.10.69:1340 CAT 16416 04.07.2007 12:50:45
Controllers IP address filters

Fr.. «| Hostname IP address From To

1 JGS_ETHCON 10.10.10.225 101000 10.10.15.255
2 RACK1_WD128_4 10.10.11.201 132.168.0.0 192.168.1.255
3 RACK1_WD128_B 10.10.11.202

4 RACK2Z_AD128_4 10.10.11.203

5 RACK2_AD128_B 10.10.11.204

Connected clients

All clients logged in are displayed in the “Connected clients” list. The number of currently
connected clients and the number of maximum allowed clients are both shown on the

status bar.
Connected clients
Uzer IP address:Port
User 178 Lock: 1 101010601161
Uzer 10 Lock: 1 10.10.10.87:49355
Uzer 178 Lock: 1 1070101181284
User 169 Lock: 1 101010691340

Active panel
SB 16x1

DB 32x2

SE 16x1
CaT 16416

Connected

04.07.2007 12:37:20
04.07.2007 12:37:25
04.07.2007 12:50:37
04.07.2007 12:50:46

The columns in the “Connected clients” list can be described as follows:

User Displays user- and lock id of the current web panel.

IP address:Port | Displays the client’s IP address and port used to connect to the server.
Active panel Displays the name of the web panel currently used by the client.
Connected Displays the time and date the client connected.
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Controllers
The “Controllers” list displays the system controllers as defined in the configuration files in
prioritized order.

Controllers

Fr.. &| Hosthame IP address

1 JG5_ETHCOM 10.10.0.225

2 RaCki_WD128_a 10.10.11.20

3 RACK1_VD128_B 1010071202

4 RaCkz_ahD128 4 101011203

5 RACKZ_AD128 B 1010171204
Priority Displays the priority of the controller. If a controller fails, the server

connects to the next controller in the list.

Hostname Displays the hostname of the controller.
IP address Displays the IP address of the controller.

IP address filters
The “IP address filters” list displays the IP filters as defined in the configuration files.

IP address filters

From To
1010000 10.10.15.255
1592.168.0.0 192.168.1.255

From The filter accepts client IP addresses from this address, inclusive.

To The filter accepts client IP addresses to this address, inclusive.

Configuration
The “Configuration” section displays the current IP address of the Web Panel server, the
currently selected configuration file and the currently selected log file destination.

Configuration
Server [P address: 1010710.78

Configuration file: C:ilnetpubby ebPanelwebConfig.xml
Log path: Chlnetpubiy ebPanelLog

5.1.1 Menu Bar
The menu bar is used for starting and stopping the server, opening configuration files and
configuring options.

File Menu
File | Actionz Toolz  F

[ Open. Chl+0

Exit Alt+F4
Open... Opens a file browse dialog for locating a configuration file. The default
file name is: “WebConfig.xml”.
Exit Stops the Web Panel server and shuts down the application.

Actions Menu
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Actionz | Tool:  Help

Stop server
Start server Starts the server if it isn’t running.
Stop server Stops the server if it is running.
Tools Menu

Toolz | Help

Internet Information Services [[15]

2] Options...
Internet Opens the 1IS configuration dialog.
Information
Services (11S)
Options... Opens the “Options” dialog. See chapter 5.1.3 for more information
about settings in the “Options” dialog.
Help Menu

Help

Dizplay computer [P settings

Releaze Log

Product ey Manager

& About

Display computer IP Shows a small dialog with the current Web Panel server

Settings IP settings.

Release Log Opens the release log for the Web Panel server.

Product Key Manager Use this to configure the product keys. See chapter 5.1.4
for more information about managing product keys.

About Displays a dialog with information about version and
copyrights.

5.1.2 Status Bar
The status bar shows the current server status, the current controller connection status and
the number of connected clients as well as the number of maximum allowed clients.

| Statuz: Server is running JGES_ETHCOM Clientz: 4415 |

Current server status. Controller Client Reserved for
connection. | connections. | future use.

5.1.3 Options
The options dialog can be opened from “Tools”->"Options...”.

nevion.com | 25



Web Panel

Rev. 5

MNevion Web Panel - Options

General | Logging

Network settings
Selectthe network interface to usefor server connections:

ILucthreaCDnnedinnz - 10 , 69 , 19 _ 106

[[] Use different network interface for client connedions

0,0, 0,0

Configuration updates
Action to perform when configuration files are updated:

@ Automatically apply new configuraion

) Ask for confirmation by user before applyina the new configuraion

Shutdown
Motify user before shutting down

OK I I Cancel

Network
settings

Select which Network Interface Card (NIC) to be used for communication
with controllers and clients. Displays the currently selected NIC and
corresponding IP address. Note it is possible to use different NICs for
controller and client connections.

Configuration

Select one of the following options:

updates — Automatically apply new configuration. If the configuration file is

modified, the modifications are automatically applied to the server.
— Ask for confirmation before applying. If the configuration file is

modified, a manual confirmation is needed in order for the
maodifications to be applied to the server.

Advanced Possibility to set virtual IPs that is used for communication with controllers

network and clients. The virtual IP is used instead of the physical IP of the network

settings interface.

nevion.com | 26




Web Panel Rev. 5

Nevion Web Panel - Options @

General | Logging

W| Logging
Laog file path

CA\WebPanehlLog

Time between logfile updates: (minutes) B0

Mew log file every hour (24 files per day)

@ Mewlogfileevery day (1file per day)

OK | | Cancel

Logging Use the “Browse” button to select the log file path. Displays the directory
where the log files are stored on the Web Panel server.

Select the number of minutes between each time the Web Panel server
writes log entries to the log file.

Select how often a new log file is created:
— New file every hour. A maximum of 24 files will be created every
day (smaller file sizes).

— New file every day (24 hours). A maximum of 1 file will be created
every day (larger file sizes).

5.1.4 Product Key Manager
The Product Key Manager holds the keys for the Web Panel server and the Nevion
Configurator, if they run on the same computer.

Click the “Add new” button to add a product key to the Product Key Manager. Click “Delete”
to delete a selected product key from the Product Key Manager. Changes to the product
keys will be applied immediately in the software.
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ﬂetwork Electronics ASA Product Key

Enter product key
User name:

Product key:

pocvvedibeervaediberevediberevedBbveeia g |

Company hame:

OK ][ Cancel ]

Enter your name, your company’s name and the new product key to add a product key to
the Product Key Manager.

If you already have a valid product key in the system, the user- and company names will be
disabled since all product keys on one computer must be registered to the same user and
company.

Warning! It is possible to change the user- and company names by clicking the
“Edit” buttons. However, this may render other product keys useless and is not
recommended. Only product keys matching the currently set user- and
company names will be activated.

5.2 Load Configuration

The configuration files are created by the Nevion Configurator and published to a local
folder on the computer running the Web Panel server.

The Web Panel Server must locate the “WebPanelConfiguration.xml” file created by Nevion
Configurator and open it. This file contains all the Web Panel button layouts, virtual router
mapping, salvos, controller settings, IP filters etc.

Select “File”->"Open...” in the Web Panel server file menu to browse for the configuration
file. The selection is saved to registry and used next time the Web Panel server is started.

Open @
- » Computer » Windows (C:) » WebPanel » w | +3 ||| Search WebPane
) C Windows (C:) » WebPanel E VebPane! o
Organize + New folder =~ [ i@}
e
- b <
% Favorites Name Date modified Type ]
Bl Desktop css 02.01.2014 21:08 File folder
& Downloads L img 02.01.2014 21:08 File folder
# Dropbox s 02.01.2014 21:08 File folder
= Recent Places lib File folder
L' lab (MESVXD3EQC Log File folder
. share (10,68.7.10) panels File folder
%/ iCloud Photos pics File folder
2| WebPanelConfiguration.xml 02.01.2014 13:20 XML Document
7 Libraries
3 Documents
. Music
l=| Pictures
Subversion
B videos
- 4 m b
File name: WebPanelConfiguration.xml - |XMLfiIes (*xml) "
[ Open ] ‘ Cancel |

nevion.com | 28



Web Panel Rev. 5

5.3 Logging

The Web Panel server can be configured to log all activities to file. Log options can be
modified in the “Options” dialog, located at “Tools”->"Options”.

Logging can be enabled and disabled using the “Logging” checkbox.

Nevion Web Panel - Options @

General | Legging

W| Logging
Log file path

C\WebPanellLog

Time between log file updates: (minutes) 601

Mew log file every hour (24files per day)

@ Mewlogfileevery day (1file per day)

oK | | Cancel

The destination of the log files can be modified by clicking the “Browse” button. All local and
network drives can be used as the log destination, which indicates the directory where the
log files will be stored.

The Web Panel server collects log entries in an internal buffer and writes the collected
entries to a log file at user defined intervals. Set the log interval as the number of whole
minutes between each time the log file is accessed.

At times with a lot of activity, the update interval should be relatively short to limit the size of
the internal log buffer. On the other hand, when there is little activity, the update interval
may be increased accordingly.

When a log entry is written to file, its timestamp is verified and a new log file is created if
necessary. The maximum number of log files created every day is user defined:

— Every hour; yields a maximum number of 24 log files per day.

— Every day; yields a maximum number of 1 log file per day.
Depending on how the log files shall be used, these configurations can be changed to fit the
needs for statistics and analysis tools.

In a normal broadcast application one log file every day and log file updates each 10 minute
is suitable.

5.3.1 Log Files
The log file is a standard ASCII text file with comma separated values. It can easily be
imported into other applications for statistics and analysis, e.g. Microsoft Excel.
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4 20070705_10.log - Notepad

File  Edit

"Client (10.10.10.78:3850) login accepted"”

Format  Yiew Help
L2007 :20,C19ent,
L2007
L2007 127,Crosspoint, 'Status:
L2007 127,Crosspoint, "Status:
L2007 127,Crosspoint,
L2007 127,Crosspoint, "Status: L8 9-30
L2007 127,Crosspoint, 'Status:
L2007 128, Crosspoint,
L2007 128,Crosspoint, Status:
L2007 128,Crosspoint, 'Status:
L2007 128,Crosspoint,
L2007 128,Crosspoint, Status:
L2007 28,Crosspoint, "Status:
L2007 128, Crosspoint,
L2007 128, Crosspoint, "Status: L8 1->0
2007 128,Crosspoint, Status:
2007 129,Crosspoint, "Cmd:
2007 129,Crosspoint, Status:
2007 129,Crosspoint, status:
2007 129,Crosspoint,
2007 129,Crosspoint, "Status: L8 2-:0
2007 28,Crosspoint, "sStatus: L108
2007 130,Crosspoint,
2007 130,Crosspoint, "Status:
2007 :EO,Crosspoint,“Status:

L8 10-:0
L108 10-»0

L1088 9-=0

L1058 0-=0

L1058 9-=0

L8 10-:0
L108 10-»0

L108 1-»0 Lock:-1 User:-1'
CAMLO to MONL by ME 16x16 (10 10.10.78)
L8 &-»>0 Lock:-1 User:-1"
Lock:-1 user:-1"
“cmd CAM3 to MONL by ME 16x16 (10.10.10.78)"
Lock:-1 user:-1"
Lock:-1 user:-1
”Cmd VwTR1L to MONl by MB 16x16 (10. 10 10.78)"
Lock:-1 uUser:-1"
Lock:-1 User:-1"

127,Ccrosspoint, "cmd: WTRL to Mownl by MB 16x16 (10.10.10.78)"
Lock:-1 uUser:-1"
Lock:-1 uUser:-1"
“Cmd: CAMLO to MOM1 by ME 16x16 (10.10.10.78)"
Lock:-1 User:-1"
Lock:-1 User:-1"
“cmd: Camd to Moml by MB 16x16 (10.10.10.78)"
L& 8-»0 Lock:-1 User:-1"
L108 8-»0 Lock:-1 uUser:-1"
"Cme: CaML to MONML by ME 16x16 (10.10,10.78)"
L8 0-»0 Lock:-1 User:-1"
Lock:-1 User:-1"
“cmd: CAMZ to MOML by MB 16x16 (10.10.10.78)"
Lock:-1 User:-1"

The log files are stored in a specific directory structure within the main log path directory as
defined in the “Options” dialog. The directory structure is created based on the log entries’
timestamps and sorts the log files after year, month, day and hour:

“.\<log path>\<year>\<month>\<date>\<log file>.log”

New folders are created every new day, month or year. Filenames are defined by the log
entries’ timestamp date and appended the hour if the interval for new log files is set to new
file every hour. In case only one log file is created per day, the time is omitted in the file

name.

=7 C:\Inetpub\WebPanel\Log\2007\06120

File  Edit

O Back -

Folders

Yiews Favorites Tools  Help

> ir y ! Search I

Address | [ C:\InetpublwebPanel\Logl 2007406120

= 13 Log
= I3 2007
® 305
= 208
oo
Doz
o3
o4
oo
oo
o7
o BH
o013
14
D15
o s
o7
s
o 1e
Do
ozt
o
o ]
24
D
i
Dz

x

~

“7 Folders E'

Mame

[£] 20070620.lag

[Z] z0070620_00.log
(2] z0070620_01.log
2] z0070620_02.l0g
[£] 20070620_03.l0g
[£] 20070620_04.l0g
[Z] 20070620_05.log
[£] z0070620_07.log
2] z0070620_08.log
[£] 20070620_09.l0g
[Z] z0070620_10.log
[Z] 20070620_11.log
[£] z0070620_12.10g
[£] z0070620_13.l0g
[£] 20070620_14.l0g
[Z] 20070620_15.log
(2] z0070620_16.log
[£] z0070620_17.l0g
1] 20070620_18.l0g
[£] 20070620_19.l0g
[Z] z0070620_20.l0g
[£] z0070620_21.l0g
2] z0070620_22.l0g
[£] 20070620_23.l0g

Size

336 KB
154 KB
130 KB
112 KB
32 KB
25 KB
SKB
1474 KB
1147 KB
1053 KB
61 KB
S02 KB
27 KB
194 KB
255 KB
62 KB
25 KB
25 KB
25 KB
25 KB
25 KB
25 KB
25 KB
25KB

Type

Text Document
Text Document
Text Dacument
Text Dacument
Text Document
Text Document
Text Document
Text Dacument
Text Dacument
Text Document
Text Document
Text Document
Text Dacument
Text Dacument
Text Document
Text Document
Text Dacument
Text Dacument
Text Dacument
Text Document
Text Document
Text Dacument
Text Dacument
Text Document

SE]

aGo

02.07.2007 10:13
29.06,2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06,2007 11:37
29.06,2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06,2007 11:37
29.06,2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06,2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06,2007 11:37
29.06,2007 11:37
29.06.2007 11:37
29.06.2007 11:37
29.06.2007 11:37

5.4 Product Keys

Each product key enables a certain amount of clients, “clients” meaning the number of

users currently logged in to the Web Panel server.

Note! If you have a 1 user license for the Web Panels you can use your own
computer, log out and then use another computer. But you cannot use two
computers at the same time.
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When you order the Web Panel product from Nevion you can choose between several
client limitations:

— 1 user license
— 5 user license
— 10 user license

If you buy a 5 user license and need to upgrade later you will receive a new product key to
be inserted into the product key manager. The number of maximum allowed clients will then
be increased according to your purchase.
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Product Warranty

The warranty terms and conditions for the product(s) covered by this manual follow the
General Sales Conditions by Nevion, which are available on the company web site:

www.nevion.com
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